

Microbial Community Analysis Using Colony-based Sequencing Database
Student Handout

Objectives

· Manipulate large datasets to conduct community-level ecological analyses
· Use community-level data to address questions about insect microbiomes
· Use Excel or RStudio programs to calculate community ecology variables
· Compare microbial community using community ecology variables

Introduction

	Microbiomes are the communities of microbes (bacteria, viruses, fungi and archaea) living symbiotically with all metazoans.  In the past decade, both interest and research on microbiomes, including their implications for human health, have increased dramatically (Christian et al. 2015, Costello et al. 2012, McFall-Ngai et al. 2013, The Human Microbiome Consortium 2012, Young 2016).  Insects have been used as model species to study the importance of microbiomes, because of their ease of use and the fact that microbial communities play diverse roles in insects (Engel and Moran 2013).  

The data that are collected in any microbiome study consists of lists of the taxonomic units identified and their abundance.  The same types of data are evaluated in an ecological community analysis, but now the communities are the collections of microbes that constitute different microbiomes. The community variables, “species” richness and relative abundance, are the same and the statistical methods used to compare communities, diversity and difference indices, also are the same.  Perhaps the simplest measure of community structure used by ecologists is “species” or taxon richness, a count of the number of unique taxa in a sample.  However, species richness does not consider the relative abundance of species in a community.  Imagine two communities with five different species.  In one community, all of the species have the same relative abundance.  In the other community, one species dominates comprising 95% of individuals in the community.  The other four species are very rare.  Based on species richness as a measure of community structure, these two communities are the same, although they are clearly very different.  As a result, ecologists use other species diversity indices that consider both the number of species and the relative abundance of species in a community.  Two common indices are the Simpson Index and the Shannon-Weaver Index.  Communities with greater numbers of species and higher evenness (i.e., similar relative abundance of species within a community) are considered more diverse.  Finally, measures of species richness and species diversity do not consider the identity of species in a community. So, communities could have the same level of species diversity, but have completely different species.  Measure of community similarity, such as the Bray-Curtis Index, compare the similarity (or dissimilarity) between two communities based on the identity of species in the communities, as well as their relative abundances. For more information on indices of species diversity and measures of community similarity, see Krebs (1999).
In this study, bean beetle gut microbiome data were collected by undergraduate students using the protocols developed by Cole et al. (2018). Three types of data were collected: colony phenotypes from cultured bacteria, 16s rRNA gene sequencing of specific bacterial colonies, and whole community 16s rRNA gene sequencing, but we will limit our analyses to the colony phenotype and colony-based 16s data.
Questions
Using data from the colony-based sequencing database and the analyses described below, answer the following questions.
1. Which taxa are most prevalent in the bacterial communities in bean beetles?
2. Do the most prevalent taxa vary based on host bean type?
3. Based on the diversity indices that you calculated, which treatment had the highest (lowest) diversity?
4. Does the answer depend on the measure of species (taxon) diversity that you use?
5. Is there a relationship between number of samples and taxonomic diversity?  If so, what might explain this?
6. Which communities are most similar (different)?
7. Do your answers to the questions above depend on the taxonomic level of analysis?
Database description
This database contains data for the microbial community of bean beetles based on 16s rRNA sequencing of individual bacterial colonies cultured from bean beetle homogenates plated on different media.  Since only a small number of colonies are sequenced from each plate, the data do not represent the entire microbial community for a particular sample.  However, qualitative comparisons can be made based on bean host species, sex of beetle, and other variables.
Access the database at https://www.beanbeetles.org/microbiome/colony-database-search/.
The database allows you to limit your search by bean host type, sex, life cycle stage, media on which bacteria were grown, colony phenotype, and bacterial taxonomy.  Since we are interested in making comparisons between bacterial communities based on host species and sex, we want to download the entire database.  Clicking “Submit” without limiting the search will allow you to view all of the data.
[image: ]
Downloading Data
While we can view the data on the website, we want to download the data to manipulate.  Click the download link to download a csv file with the data. Then, save the file as an Excel file (name the file “colony-based sequence data”) and rename the tab “raw data.” 
[image: ]
[image: ]Double click tab and rename as “raw data”

Data Reduction
1. Make a copy of the raw data in a new sheet using the sheet copy function in Excel (right click on the tab and select “Move or copy” and rename the tab (“reduced raw data”).
[image: ]Right click on tab and select “Move or Copy”.

[image: ]Select “Move to end” and check “Create a copy”

2. In the “reduced raw data” sheet, delete any columns that we don’t need, such as the colony phenotype (color, gloss, form, elevation) and sequence data columns.  The “reduced raw data” sheet is the data source if you choose to analyze these data in RStudio.  Additional data manipulation and formatting (below) is required if you choose to analyze these data in Excel. 
Data manipulation
1. We need to consolidate the data for each host species, each sex, or the combination of the two by the bacterial taxa.  The easiest way to do this is with the Pivot Table function in Excel.
2. When clicked on a cell within the data, create a Pivot Table (Insert -> Pivot Table OR Data -> Summarize with Pivot Table). Make sure that the data source includes the top row (the cell range should include “$A$1”), which has the column headings.  Click OK to create the pivot table in a new worksheet and label the tab “pivot table”. 
[image: ]
[image: ]Make sure that the cell range includes $A$1

3. Set the treatment(s) that you are interested (for example, host species) in as the rows and the bacterial taxonomic level you are interested in as the columns. The Values should be a COUNT of the sample_id, as each row in the dataset represents a single sample.

[image: ]Drag treatment of interest (e.g., host) to ROWS, taxonomic level (e.g., genus) to COLUMNS, and sample_id to VALUES


4. You can add zeros to all of the empty cells in the Pivot Table using the Options menu and remove the Grand totals for Columns using the Options menu or the Design tab depending of your version of Excel. (You want to keep the Grand totals for rows to calculate diversity indices.)

[image: ]
[image: ]Unselect checkbox for “Show grand totals for columns”

5. You can remove the “blanks” column using the Column labels dropdown (located at upper left of the sheet) and unselecting “blank”.
[image: ]Unselect checkbox for “blanks”

6. If you selected more than one treatment for the rows, you can get the treatment data to repeat for each sample. In the Design tab, select “Report Layout” and choose “Show in Tabular form” and “Repeat All Item Labels”.
[image: ]
7. Copy and paste (as values) the pivot table to a new worksheet and remove any extra rows at the top.  The top row should now have the taxa names. Name this tab “analysis”.  Conduct the community ecology analyses that follow in Excel on the “analysis” sheet.
[image: ]
Calculating diversity indices
1. Species (taxon) richness – the number of unique species (taxa) in a sample
a. Although you could manually count the number of cells with values greater than zero for each treatment, using the COUNTIF formula in Excel is easier (e.g., =COUNTIF(range,”>0”)).  Where “range” is the cell range in the datasheet, for example “C2:M2”, a single row or treatment.
[image: ]
2. Simpson Index – the Simpson Index incorporates both species (taxon) richness and species (taxon) evenness.
a. D = Ʃ(n/N)^2, where n=number of individuals of a particular species (taxon) and N=total number of individuals in a sample.  D increases as diversity decreases, which is counterintuitive.  A reciprocal or inverse index would be more intuitive and are easily calculated.
b. Reciprocal Simpson = 1/D and scales so the maximum value is the species richness of a community.
c. Inverse Simpson = 1-D and scales to a maximum value of 1.0.
d. Create a new data array below the original using the same row labels (treatment variables) and the same column labels (bacterial taxa).
[image: ]
e. To calculate the proportion squared for each taxa, use the grand totals for each treatment.  Using the Excel trick that $ before a column or row prevents Excel from iterating when copying a formula makes this easy. For example, =(C2/$P2)^2. Copy the formula across the row and then down.
[image: ]=(B2/$P2)^2. B2 is the cell with the abundance of the first taxon and P2 is the cell with the grand total for a treatment. The $ prevents the column identifier from changing. Copy the formula across the row and then down.


f. Calculate the sum of the proportions squared (=SUM in Excel) to calculate the Simpson Index.
[image: ]=SUM(C9:O9). C9 is the first cell in the row and O9 is the cell with the last proportion for a treatment. 

g. Calculate the reciprocal (e.g., =1/P9) and inverse Simpson (e.g., =1-P9) using formulas in Excel.

3. Shannon-Weaver (Shannon-Weiner) Index – also incorporates species (taxon) richness and species (taxon) evenness
a. H=-Ʃplnp, where p is the proportion of individuals of each bacterial taxon in a community (i.e., n/N).
b. Create a new data array below the original using the same row labels (treatment variables) and the same column labels (species).
c. Using the grand totals for each treatment, calculate the proportions (plnp).  Using the Excel trick that $ before a column or row prevents Excel from iterating when copying a formula makes this easy.
d. Note that lnp is undefined if p=0, so you can use an “IF” statement in Excel.  For example, =IF(B2>0,(B2/$P2)*LN((B2/$P2)),"")
[image: ]=IF(B2>0,(B2/$P2)*LN((B2/$P2)),""). B2 is the cell with the abundance of the first taxon and P2 is the cell with the grand total for a treatment. The $ prevents the column identifier from changing. Copy the formula across the row and then down.


e. Calculate the negative sum of the proportions (plnp) (=-SUM in Excel for each row, a different microbial community) to calculate the Shannon-Weaver Index.

[image: ]= -SUM(B15:O15). B15 is the first cell in the row and O15 is the cell with the last proportion for a treatment. 



Data Manipulation in R
1. Open RStudio and create a new project using the New Project option under File and select for the new project to be in an existing folder where your data are.
2. Install the following packages either using the Packages tab in RStudio or the command install.packages(“name_of_package”) in the console. Note that BiodiversityR requires QuartzX on a Mac.  If you are using a MacOS and don’t have QuartzX, install it first and restart your computer before install these packages.
a. dplyr
b. reshape2
c. vegan
d. BiodiversityR
e. ggplot2


[image: ]Type the name of the package here and click Install.

3. Load the packages listed above by clicking the checkboxes for the appropriate packages in the Packages tab or the command library(“name_of_package”) in the console.
4. Import the dataset “reduced raw data” (dataset without the extra metadata that you created in the Excel section) into RStudio.

[image: ][image: ]Set Name to “colony” and use Sheet dropdown to select appropriate worksheet from Excel file.
Browse to select file from your computer


5. Attach the imported dataset (“colony”) to the dataframe using the attach command in the console (attach(colony)) 
6. Create a community matrix (named “community” in this example) for a particular treatment. This example assumes that you are doing the analysis at the genus level.  This can be changed to other taxonomic levels using the appropriate variable name

	>community<-table(host,genus)
7. If you want to look at two factors at the same time, creating the community matrix is a little more complicated.  The first command calculates the count of each genus by each sex and host combination and drops any missing values.  The second command creates a community matrix.

> community_2 <- colony %>% count(sex,host,genus) %>% drop_na()
> comm2<-dcast(community_2, sex+host~genus, value.var = "n", fun.aggregate = sum)
“genus” in both command lines may be whatever taxon level you wish to evaluate in the dataset.  For example, it could be changed to “family” or “order”.
Calculating diversity indices 
Note: “community” is the name of the community matrix
1. Species Richness
	
	> diversityresult(community,index="richness",method="each site")

2. Simpson

	> diversityresult(community,index="Simpson",method="each site")

	This calculates the inverse Simpson described above

	
	> diversityresult(community,index="inverseSimpson",method="each site")
	
	This calculates the reciprocal Simpson described above. (confusing that it is called in the 
	inverseSimpson)

3. Shannon

	> diversityresult(community,index="Shannon",method="each site")


Calculating community similarity (distance)
Sometimes we are interested in how similar (or different) two communities are based on what species (taxa) are present and the relative abundance of those species (taxa) in the two communities. One of the most common measures of distance is the Bray Curtis Dissimilarity.  Similarity can be measured as 1-BC.


Where:
· i & j are the two samples, 
· Si is the total number of specimens counted in sample i,
· Sj is the total number of specimens counted in sample j,
· Cij is the sum of only the lesser counts for each taxa found in both sites.
Although Bray-Curtis Dissimilarity is often used in community ecology, it is not robust to incomplete sampling of the community (all taxa are not sampled) or unbalanced sampling (all treatments are not equally sampled). An alternative is the Morista-Horn Index of Dissimilarity (1-CH).  Morista-Horn Index of Similarity is

Where
· D1=number of taxa in sample 1
· D2=number of taxa in sample 2
· D12=number of taxa in shared in both communities
· Xi=number of individuals of taxon i in sample 1
· Yi=number of individuals of taxon i in sample 2
· n=total number of individuals in sample 1
· m=total number of individuals in sample 2
So that Xi/n and Yi/m are proportion of individuals of taxon i in each of the samples (communities).

To produce a matrix of all of the pair-wise distances between samples using the Bray Curtis index of distance, use the            following command.

> vegdist(community, method="bray", binary=FALSE, diag=FALSE, upper=FALSE)


To produce a matrix of all of the pair-wise distances between samples using the Morista-Horn index of distance.


> vegdist(community, method="horn", binary=FALSE, diag=FALSE, upper=FALSE)
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9 |EMORY_SIEMORY Stadzuki female adult  Blood aga offwhite matte iregular flat Firmicute:Bacilli  Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]
10 EMORY_SIEMORY Siadzuki female adult  PEA  offwhite shiny  circular raised  Firmicute:Bacilli  Bacillales Staphyloc Staphyloc ACTGCAGTCGAGCGAACAGATAAGGAGCTTGCTCCTTTGACGTTAGCGGCGGACGGGTGAGTAACACGTGGGTAACCTA

11|EMORY_SIEMORY SIBEP  male  adult  PEA  yellow shiny  circular raised  Firmicute:Bacilli  Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/106plate1]
12 [EMORY_SIEMORY Simung  male  adult  Bloodagapink  shiny  circular craterifor Proteobac Gammapr Enterobac Enterobacteriaceae ANNNTGCAAGTCGAGCGGTANCACAGAGAGCTTGCTCTCGGGTGACGAGCGGCGGACGENNNNNNAANGTCTGGGAA

13 [EMORY_SIEMORY Siadzuki female adult ~ PEA  white matte circular raised  Firmicute:Bacilli  Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/114plate1]
14 [EMORY_SIEMORY Siadzuki female adult  Bloodagawhite  matte irregular flat Firmicute:Bacilli  Bacillales staphyloc Staphyloc NNNNNN https://wr https://w https://www.beanbeetles.org/new_website/search/EMORY_sP1/110plate1]
15 |[EMORY_SIEMORY SIBEP  female adult ~ PEA  white matte iregular raised  Firmicute:Bacilli Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]
16 [EMORY_SIEMORY Siadzuki  male  adult  PEA  offwhite shiny  circular raised  Firmicute:Bacilli  Lactobacil Enterococ Enterococ TCGGAACGCTTCTTTCCTCCCGAGTGCTTGCACTCAATTGGAAAGAGGAGTGGCGGACGGGTGAGTAACACGTGGGTAACK

17 |EMORY_SIEMORY SIBEP  female adult  Bloodagawhite  shiny circular raised  Proteobac Gammapr Pseudom¢PseudomPseudom¢NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]
18 [EMORY_SIEMORY Simung  female adult  PEA  offwhite shiny  circular convex Firmicute:Bacilli  Bacillales Staphyloc Staphyloc NNNNNNNNNNNNNNNNNNNNNNNCTGNNGTCGAGCGAACAGATAAGGAGCTTGCTCCTTTGACGTTAGCGGCGGAS
19 |EMORY_SIEMORY SIBEP  male  adult  PEA  white shiny iregular raised  Firmicute:Bacilli Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/106plate1]

20 |EMORY_SIEMORY_SiBEP male  adult  PEA offwhite shiny  circular convex Firmicute:Bacil Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/106plate1]
21|EMORY_SIEMORY Siadzuki female adult  Bloodagaorange shiny  circular flat Proteobac Gammapr Enterobac Enterobac Enterobac NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]
22 [EMORY_SIEMORY Siadi = o PEA white  shiny irregular raised  Firmicute:Baci Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/114plate1]
23|EMORY_SIEMORY_SiBel PEA white  shiny irregular raised  Firmicute:Baci Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/110plate1]
24 |EMORY_SIEMORY_simy &% Delete EMB white  shiny  circular raised  ProteobacGammapr Enterobac Enterobac Enterobac CAAGCAGCTTGCTGCTTCGCTGACGAGTGGCGGACGGGTGAGTAATGTCTGGGAAACTGCCTGATGGAGGGGGATAACTA
25|EMORY_SIEMORY_Siad;  Bename Bloodagawhite  shiny circular raised  ProteobacGammapr Enterobac Enterobac Enterobac NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/114platel
26 |EMORY_SIEMORY_Sfad:| " Move or Copy... Bloodagawhite  shiny irregular flat Firmicute: Bacil Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]
27 |EMORY_SIEMORY_Sfadi =7 yic,,Coge Blood agar Proteobac Gammapr Enterobac Enterobac Enterobac CCTGCNAGTCGAACGGTAACAGGAAGCAGCTTGCTGCTTCGCTGACGAGTGGCGGACGGGTGAGTAATGTCTGGGAAA

28 |EMORY_SIEMORY_Stad:
29 |EMORY_SIEMORY_Stad:

PEA  offwhite matte irregular raised  Firmicute:Baci
Firmicute:Bacil

Lactobacil Enterococ Enterococ NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_sP18/110plate1]

Brotect Sheet.
B e Bacillales staphyloc Staphyloc NNNNNN https://wr https://w https://www.beanbeetles.org/new_website/search/EMORY_SP17/114_E 5 1

30 |EMORY_SIEMORY_sipg| ~ L2b Color v EMB yellow shiny  circular raised Firmicute:Baci Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]
31 |[EMORY_SIEMORY_Sfad:  Hide eve shiny circular raised  Bacteroid:BacteroidiSphingob: Sphingob Sphingob: NNNNNN https://w! https://w hitps://www.beanbeetles.org/new_website/search/EMORY_SP18/110plate1]
32 |EMORY_SIEMORY_Simu PEA offwhite matte circular raised  Firmicute: Bacil Lactobacil Enterococ Enterococ NNNNNN https://wr https://w https://www.beanbeetles.org/new_website/search/EMORY_SP17/110_A 6_|
33|EmORY_SiEmORY stadi o PEA white  shiny irregular raised  ProteobacGammapr Enterobac Enterobac Enterobac NNNNNN https://wt https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/114platel
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1 [experime] sample_it host sex stage  media color  gloss  form  elevation phylum class  order  family genus  sequenceseq_file pdf. f
2 [EMORY_SIEMORY SIBEP  male  adult  PEA  white shiny  circular raised  Firmicute:Bacilli  Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/114plate1]
3 |EMORY_SIEMORY SIBEP  female adult  Bloodagawhite  matte imegular raised  Firmicute:Bacilli  Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/110plate1]
4 |EMORY_SIEMORY Siadzuki female adult  EMB  red shiny circular flat Proteobac Gammapr Enterobac Enterobac Enterobac NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]
5 |EMORY SIEMORY Simung  male  adult  Nutrient/white  shiny  circular raised  ProteobacGammapr Enterobac Enterobac Enterobac CGGTAACAGGAAGCAGCTTGCTGCTTTGCTGACGAGTGGCGGACGGGTGAGTAATGTCTGGGAAACTGCCTGATGGAGG
6 |[EMORY_SIEMORY SIBEP female adult  Blood aga offwhite matte circular umbonate Firmicute:Bacilli  Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/110plate1]
7 |[EMORY_SIEMORY Siadzuki female adult  PEA  white  shiny  circular convex Firmicute:Bacilli Bacillales Staphyloc Staphyloc GAGCTTGCTCCTITGACGTTAGCGGCGGACGGGTGAGTAACACGTGGGTAACCTACCTATAAGACTGGGATAACTTCGGG:
5 |[EMORY_SIEMORY Simung  male  adult  Nutrientfwhite  shiny  circular raised ProteobacGammapr Enterobac Enterobac Enterobac NNNNNNNNNNNNNNNNNNNNNTGNNNTCGANCGGTAACAGGAAGCAGCTTGCTGCTTCGCTGACGAGTGGCGGACH
9 |EMORY_SIEMORY Stadzuki female adult  Blood aga offwhite matte iregular flat Firmicute:Bacilli  Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]
10 EMORY_SIEMORY Siadzuki female adult  PEA  offwhite shiny  circular raised  Firmicute:Bacilli  Bacillales Staphyloc Staphyloc ACTGCAGTCGAGCGAACAGATAAGGAGCTTGCTCCTTTGACGTTAGCGGCGGACGGGTGAGTAACACGTGGGTAACCTA

11|EMORY_SIEMORY SIBEP  male  adult  PEA  yellow shiny  circular raised  Firmicute:Bacilli  Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/106plate1]
12 [EMORY_SIEMORY Simung  male  adult  Bloodagapink  shiny  circular craterifor Proteobac Gammapr Enterobac Enterobacteriaceae ANNNTGCAAGTCGAGCGGTANCACAGAGAGCTTGCTCTCGGGTGACGAGCGGCGGACGENNNNNNAANGTCTGGGAA

13 [EMORY_SIEMORY Siadzuki female adult ~ PEA  white matte circular raised  Firmicute:Bacilli  Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/114plate1]
14 [EMORY_SIEMORY Siadzuki female adult  Bloodagawhite  matte irregular flat Firmicute:Bacilli  Bacillales staphyloc Staphyloc NNNNNN https://wr https://w https://www.beanbeetles.org/new_website/search/EMORY_sP1/110plate1]
15 |[EMORY_SIEMORY SIBEP  female adult ~ PEA  white matte iregular raised  Firmicute:Bacilli Bacillales Staphyloc Staphyloc NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]
16 [EMORY_SIEMORY Siadzuki  male  adult  PEA  offwhite shiny  circular raised  Firmicute:Bacilli  Lactobacil Enterococ Enterococ TCGGAACGCTTCTTTCCTCCCGAGTGCTTGCACTCAATTGGAAAGAGGAGTGGCGGACGGGTGAGTAACACGTGGGTAACK

17 |EMORY_SIEMORY SIBEP  female adult  Bloodagawhite  shiny  circular raised  Proteobac Gammapr Pseudom¢PseudomPseudom¢NNNNNN https://w: https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]

18 |EMORY_SIEMORY_Simung __female adult  PEA offwhite shiny  circular convex Firmicute:Bacil Bacillales Staphyloc Staphyloc NNNNNNNNNNNNNNNNNNNNNNNCTGNNGTCGAGCGAACAGATAAGGAGCTTGCTCCTTTGACGTTAGCGGCGGA
19|EM Move or Copy 2 x PEA white  shiny irregular raised  Firmicute:Baci Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/106plate1]
20| PEA offwhite shiny  circular convex Firmicute:Bacil Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/106plate1]
21 e ;"u";:;:"‘"’ sheets Blood aga orange  shiny  circular  flat Proteobac Gammapr Enterobac Enterobac Enterobac NNNNNN https://wn https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116platel
22 B | e sequence datasic S| pea white  shiny irregular raised  Firmicute:Baci Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/114plate1]
23 PEA white  shiny irregular raised  Firmicute:Baci Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/110plate1]
24 e %:':';:m EMB  white  shiny  circular raised  ProteobacGammapr Enterobac Enterobac Enterobac CAAGCAGCTTGCTGCTTCGCTGACGAGTGGCGGACGGGTGAGTAATGTCTGGGAAACTGCCTGATGGAGGGGGATAACTA
25 nd) Blood agawhite  shiny circular raised  ProteobacGammapr Enterobac Enterobac Enterobac NNNNNN https://wi https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/114platel
26 | Blood aga white  shiny irregular flat Firmicute: Bacil Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116plate1]
27 Blood agar Proteobac Gammapr Enterobac Enterobac Enterobac CCTGCNAGTCGAACGGTAACAGGAAGCAGCTTGCTGCTTCGCTGACGAGTGGCGGACGGGTGAGTAATGTCTGGGAAAC
28 PEA offwhite matte irregular raised  Firmicute: Bacil Lactobacil Enterococ Enterococ NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/110plate1]
29| Firmicute: Bacil Bacillales Staphyloc Staphyloc NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP17/114_E_5_]
30 |EI {Create a copy! EMB. yellow shiny  circular raised  Firmicute:Bacil Bacillales Staphyloc Staphyloc NNNNNN https://w https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/116platel
31 = — EMB shiny circular raised  BacteroidiBacteroidi Sphingob: Sphingobs Sphingob: NNNNNN https://w https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/110platel
32| PEA offwhite matte circular raised  Firmicute:Bacil Lactobacil Enterococ Enterococ NNNNNN https://w! https://w https://www.beanbeetles.org/new_website/search/EMORY_SP17/110_A_6_|
33|EMORY_SIEMORY_Sfadzuki female |adult  PEA white  shiny irregular raised  ProteobacGammapr Enterobac Enterobac Enterobac NNNNNN htps://wt https://w https://www.beanbeetles.org/new_website/search/EMORY_SP18/114platel _
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1 |experime sample_it host sex stage  media phylum class  order  family  genus

2 |EMORY_SIEMORY_SIBEP male  adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

3 |EMORY_SIEMORY_SIBEP female adult  Blood aga Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus.

4 |EMORY_SIEMORY_Siadzuki  female adult  EMB Proteobac Gammapr Enterobac Enterobac Enterobacter

5 [EMORY_S|EMORY_Simung  male  adult  Nutrient £Proteobac Gammapr Enterobac Enterobac Enterobacter

6 |EMORY_SIEMORY_SIBEP female adult  Blood aga Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

7 |EMORY_SIEMORY Siadzuki female adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

8 |[EMORY_SIEMORY Simung  male  adult  Nutrient £Proteobac Gammapr Enterobac Enterobac Enterobacter

9 |EMORY_SIEMORY_Siadzuki female adult  Blood aga Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

10 |[EMORY_SIEMORY_Sladzuki female adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

11 |EMORY_SIEMORY_SIBEP male  adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

12 |[EMORY_SIEMORY_Simung  male  adult  Blood aga Proteobac Gammapr Enterobac Enterobacteriaceae

13 |[EMORY_SIEMORY_Sladzuki female adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

14 |[EMORY_SIEMORY_Sladzuki female adult  Blood aga Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

15 |[EMORY_SIEMORY_SIBEP female adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

16 |[EMORY_SIEMORY_Siadzuki male  adult  PEA Firmicute:Bacilli  Lactobacil Enterococ Enterococcus

17 |EMORY_SIEMORY_SIBEP female adult  Blood aga Proteobac Gammapr Pseudom:Pseudom¢ Pseudomonas

18 |[EMORY_SIEMORY_Simung  female adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

19 |EMORY_SIEMORY_SIBEP male  adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

20 |EMORY_SIEMORY_SIBEP male  adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

21 |EMORY_SIEMORY_Siadzuki  female adult  Blood aga Proteobac Gammapr Enterobac Enterobac Enterobacter

22 |EMORY_SIEMORY_Sladzuki male  adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

23 |EMORY_SIEMORY_SIBEP male  adult  PEA Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

24 |EMORY_SIEMORY_Simung ~ male  adult  EMB Proteobac Gammapr Enterobac Enterobac Enterobacter

25 |EMORY_SIEMORY_Siadzuki male  adult  Blood aga Proteobac Gammapr Enterobac Enterobac Enterobacter

26 |EMORY_SIEMORY_Siadzuki  female adult  Blood aga Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

27 |EMORY_SIEMORY_Siadzuki male  adult  Blood aga Proteobac Gammapr Enterobac Enterobac Enterobacter

28 |EMORY_SIEMORY_Siadzuki male  adult  PEA Firmicute:Bacilli  Lactobacil Enterococ Enterococcus

29 |EMORY_SIEMORY_Siadzuki  female  adult Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

30 |EMORY_SIEMORY_SIBEP female adult  EMB Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus

31 |EMORY_SIEMORY_Siadzuki  female adult  EMB. Bacteroid:Bacteroidi Sphingob: Sphingob: Sphingobacterium

32 [EMORY_SIEMORY_Simung ~ male  adult  PEA Firmicute:Bacilli  Lactobacil Enterococ Enterococcus

33 |EMORY_SIEMORY_Sladzuki  female adult  PEA Proteobac Gammapr Enterobac Enterobac Enterobacter -
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2 |[EMORY_SIEMORY SIBEP  male  adult  PEA  Firmicute:Bacilli Bacillales Staphyloc Staphylococcus T
3 |EMORY_SIEMORY SIBEP  female adult  Blood aga Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus Use this workbook's Data Model
4 |EMORY_SIEMORY Siadzuki female adult  EMB  ProteobacGammapr Enterobac Enterobac Enterobacter e e P OTTaLte et e b peatee]
5 |EMORY SIEMORY Simung  male  adult  Nutrient £ Proteobac Gammapr Enterobac Enterobac Enterobacter o e
6 |[EMORY_SIEMORY SIBEP  female adult  Blood aga Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus O Bisting Worksheet
7 |EMORY_SIEMORY Siadzuki female adult  PEA  Firmicute:Bacilli Bacillales Staphyloc Staphylococcus i
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o |EMORY_SIEMORY Siadzuki female adult  Blood aga Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus (R
10 |EMORY_SIEMORY Sladzuki female adult  PEA Firmicute:Bacilli Bacillales Staphyloc Staphylococcus -
11 EMORY_SIEMORY SIBEP  male  adult  PEA  Firmicute:Bacilli Bacillales Staphyloc Staphylococcus oK Cancel
12 |EMORY_SIEMORY Simung  male  adult  Blood aga Proteobac Gammapr Enterobac Enterobacteriaceae
13 |EMORY_SIEMORY Siadzuki female adult  PEA Firmicute:Bacilli Bacillales Staphyloc Staphylococcus
14 |EMORY_SIEMORY_Sladzuki female adult  Blood aga Firmicute:Bacilli Bacillales Staphyloc Staphylococcus
15 EMORY_SIEMORY SIBEP  female adult  PEA  Firmicute:Bacilli Bacillales Staphyloc Staphylococcus
16 EMORY_SIEMORY Siadzuki male  adult  PEA Firmicute:Bacilli Lactobacil Enterococ Enterococcus
17 EMORY_SIEMORY_SIBEP female adult  Blood aga ProteobacGammapr Pseudom(PseudomPseudomonas
18 EMORY_SIEMORY Simung  female adult  PEA Firmicute:Bacilli Bacillales Staphyloc Staphylococcus
19 EMORY_SIEMORY SIBEP  male  adult  PEA  Firmicute:Bacilli Bacillales Staphyloc Staphylococcus
20 [EMORY_SIEMORY_SIBEP  male  adult  PEA  Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus
21 |EMORY_SIEMORY_Stadzuki female adult Blood aga Proteobac Gammapr Enterobac Enterobac Enterobacter
22 [EMORY_SIEMORY_Stadzuki  male  adult  PEA  Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus
23 [EMORY_SIEMORY_SIBEP  male  adult  PEA  Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus
24 [EMORY_SIEMORY_Simung  male  adult  EMB  ProteobacGammapr Enterobac Enterobac Enterobacter
25 |[EMORY_SIEMORY_Stadzuki  male  adult Blood aga Proteobac Gammapr Enterobac Enterobac Enterobacter
26 [EMORY_SIEMORY_Stadzuki  female adult  Blood aga Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus
27 |EMORY_SIEMORY_Stadzuki  male  adult Blood aga Proteobac Gammapr Enterobac Enterobac Enterobacter
28 [EMORY_SIEMORY Stadzuki male  adult  PEA  Firmicute:Bacilli Lactobacil Enterococ Enterococcus
29 [EMORY_SIEMORY_Stadzuki  female  adult Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus
30 [EMORY_SIEMORY_SIBEP  female adult  EMB  Firmicute:Bacilli  Bacillales Staphyloc Staphylococcus
31 |EMORY_SIEMORY_Stadzuki female adult  EMB  Bacteroid(BacteroidiSphingobSphingob: Sphingobacterium
32 |[EMORY_SIEMORY Simung  male  adult  PEA Firmicute:Bacilli Lactobacil Enterococ Enterococcus
33 [EMORY_SIEMORY_Stadzuki female adult  PEA  ProteobacGammapr Enterobac Enterobac Enterobacter
34 |EMORY_SIEMORY_Stadzuki  female  adult Proteobac Gammapr Enterobac Enterobacteriaceae
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